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1. Introduction 
 
 
SeaStar is supporting software for the DST comp-tilt Data Storage Tag.  
SeaStar can run under Win98, Win 2000, WinXP, WinNT and Vista.  
This manual takes you step-by-step through the program installation, 
hardware connections and use of the SeaStar Program.  New updates of 
SeaStar will be available for free download at: 
http://www.star-oddi.com/Online-Support/Software-updates/. 
Please note that the downloaded file has to be installed into the existing 
SeaStar folder. The update alone is not a complete program and therefore 
will not work like that. Follow the instructions on the update website for 
correct installation. 
 
This manual guides the users of DST comp-tilt through the operation of 
the recorder.  Setting the operating parameters as well as data retrieval 
requires access to a PC computer with a standard RS-232C serial 
interface or USB.   
 
DST comp-tilt is a compact microprocessor-controlled comp-tilt, 
temperature and depth recorder with electronics housed in a waterproof 
ceramic housing. 
 
The sensors are located as shown on the diagram below.  
 
 
 
 

 
 

Figure 1.1 DST sensors 
 
 
It is extremely important that the area is kept free where the pressure 
sensor is, to allow free flow of water/liquid to the temperature and 
pressure sensors. Please note that the pressure sensor membrane is 
fragile, and objects should not be pressed against it, as it might cause 
damage. 
 

Pressure (depth) sensor 

Temperature sensor 

Compass 

Tilt 
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Install 
 
The installation program is on the SeaStar CD.  Insert the CD into your 
compact disc drive.  To install the program, follow the automatic 
InstallShield Wizard. 
 
Follow the instructions on the screen.  You will be prompted for a 
directory name for your SeaStar program.    
 
 
Uninstall 
 
To uninstall the program, do the following: 

1. Click on the Start button in Windows. 
2. Go to Settings and Control Panel. 
3. Choose Add/Remove Programs. 
4. Choose SeaStar and click on Change/Remove, and ‘Yes to all’. 
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2. Preparation 
 
 
This chapter describes preparations that should be carried out before 
connecting to the recorder. 
 
Start SeaStar and the following window appears: 
 

 

Figure 2.1  SeaStar main window 
 
 
Select recorder type 
 
SeaStar is compatible with other Star-Oddi instruments.  A recorder type 
must be selected before connecting to the recorder.  The default setting 
in the software is set to Starmon mini as a recorder type.  Change the 
recorder type to DST comp-tilt by doing the following: 

1. Choose the File menu and the New Recorder Type command.   
2. Select DST comp-tilt as a recorder type.   
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Figure 2.2  Select DST comp-tilt as recorder type 
 
Before connecting to the recorder, it is important that the clock on the PC 
computer is correct.  This is important since the recorder automatically 
downloads the PC clock settings. 
 
 
Configuration of the communication port 
 
It is necessary to define which serial port on your PC computer you will 
use for connecting the Communication Box.  This is done in the following 
way: 

1. Choose the Communication command in the Settings menu.   
The Communication definition dialog box appears. 

2. Select a serial port for communications. 
3. Choose the OK button. 

 
 

 

Figure 2.3  Communication port configuration 
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To check which communication ports are available on your computer, 
open your Device Manager. On Windows XP you can do it following way: 
Control panel > system > hardware > device manager. 
Under Ports you can view all available ports. Make sure that the port you 
are intending to use is enabled: right-click on the appropriate port and 
select properties. Under ‘Device usage’ it should state ‘use this device 
(enable)’. 

 

                                    Figure 2.4  Enable communication port 
 
 
Using the USB serial converter 
 
If you are using the USB serial converter you will need to install the driver 
first that comes on the provided CD. Please, read the ‚Quick Installation 
Guide‘ booklet to get further instruction on how to proceed.  
 
After you plug in the USB cable you will see a new communication port in 
your device manager, called ‚Prolific USB-to-Serial Comm Port‘. Make 
sure that the port is enabled and select the appropriate port in SeaStar. 
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                       Figure 2.5  USB communication port in Device Manager 
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3. Communication Box 
 
 
This chapter provides details concerning the Communication Box and 
how to place recorder in the box prior to connection. 
 
Communication Box 
 
The DST Communication Box is a PC-RS-232C compatible 
communication interface, specially designed to communicate with DST 
recorders wirelessly via RF (radio frequency).  A USB serial converter plug 
can optionally be used with the Communication Box.   
 
The Communication Box has three diodes: 
1. Red – shows that power is fed from the power supply to the 
Communication Box. 
2. Yellow – shows that SeaStar has made connection with the box, DST 
comp-tilt has been selected as a recorder type and that correct COM 
port has been selected.    
3. Green – shows that recorder is in correct position for seeking 
connection. 
 
Connect the serial cable between the serial port of the computer and the 
Communication Box.  Plug the power supply connection to a power-
socket.  The voltage from the power supply should be set to 9V, although 
there is no damage to use up to 20V.  Before inserting the power plug 
into the box, it is important to note that the polarity should be:  
 

–(O+      (minus on the outside and the plus on the inside). 
   
The polarity is usually shown where the arrows meet on the power plug, 
and the power supply.  After the power supply has been connected to the 
Communication Box, the red light should be on.  After SeaStar has been 
started, the yellow light should be on (if correct COM port is selected). 
  
The box will power the recorder while communicating with the PC.  In 
case the battery is dead, the PC and interface are still able to connect to 
the recorder and retrieve data.   
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Connection point 
 
In order to get the green light, the red and the yellow light must be on.   
The recorder is inserted into the hole of the box as shown in the figure 
below: 
 
 
 

 
 

Figure 3.1   Inserting recorder into the Communication Box 
 
 
If the recorder has been recording in the waters, then please wipe it dry 
before inserting it into the box.  The spherical end of the recorder faces 
down and flat end faces up.  Recorder is rotated until the green light 
illuminates.   
When green light is on, communication can be established with the 
software.  For best connection conditions, recorder is placed in the 
middle of the area where the green light is on.   
For our latest products we have added a mark on both the housing and 
the Communication Box to help finding the right position. Simply turn the 
logger until the small grey mark on top of the sensor meets the marking 
that is drilled into the surface of the Communication Box.   
If the recorder fails to connect, please refer to the ‘Troubleshooter’ 
chapter. 
 
 

Communication Box 

DST comp-tilt
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4. DST comp-tilt 
 
General description 
 
The DST comp-tilt measures additionally to temperature and depth, 
compass heading of the DST (with reference to the magnetic north) and 
tilt in 3-D three directions (with reference to the Earth gravity). The 
measuring parameters are measuring the magnetic field in two directions 
in the horizontal plane to give the comp-tilt heading in degrees (°).  The 
diagram below shows the measuring directions of the sensor relative to 
the DST housing.  In this position the heading (nose of housing) is west 
(270°). 
  
 
 

 
Figure 4.1  DST Comp-tilt 

 
The performance of the DST comp-tilt is optimal when it is placed in the 
horizontal plane, the further the comp-tilt pitches and/or rolls from the 
horizontal plane the larger the error reading becomes.  However the 3-D 
tilt measurements compensate for the pitching and rolling, minimizing the 
compass heading error. 
 
The recorder needs to be placed horizontally on the subject, having the 
nose facing in the same direction as the subject is moving (for example if 
the DST is attached to fish, the nose of the DST should face in the same 
direction as the nose of the fish). Normally the two holes should have the 
same distance from the flat plane and housing text (DST comp-tilt or 
specified text) face up.  A mark on the end of the recorder’s flat end 
should face directly up.  The data are shown in degrees: 
0° = North 
90°= Easth 
180°= South 
270°= West 



User’s Manual                SeaStar graphic supporting software 
 

14 

Other measurements in between, like 45° would mean N/E etc... 
 
In the SeaStar software you can define if the data point resolution of the 
comp-tilt measurements should be 4 point, 8 point or 16 point degree.  
This is defined under 'Settings - Preferences - Units'. 
 
Hands on description 
 
DST comp-tilt is calibrated at Star-Oddi, but it's possible that the sensor's 
direction may differ slightly in other surroundings, including underwater 
environments.  Therefore it is recommended that the user performs 
reference measurements at the beginning of a measuring period.  For that 
purpose, please synchronize your own clock with the PC computer’s 
clock, to see in which directions the recorder is placed at each time. If you 
have a standard compass meter, it would be useful to do some 
comparison measurements.   
 
Also because the horizontal and vertical components of the Earth's 
magnetic field vary considerably in different locations it is possible to 
calibrate the compass in SeaStar, under 'Edit - Reconvert Definitions - 
Compass Definitions' and put in an offset value for declination (more on 
pages 47-48).  
 
To understand declination it should first be realized that there are two 
North Poles. There is a True Geographic North Pole at the top of the 
world, and a Magnetic North Pole which is over 1,250 miles from the True 
North Pole. A magnetic compass like DST comp-tilt always points toward 
the Magnetic North Pole. Maps are oriented to the True North Pole. The 
angular difference between True North Pole and Magnetic North is called 
declination. Declination varies from 0 to 30 degrees in most populated 
regions of the world. These declination values usually change slightly over 
time, as the Earth’s plates shift. The actual value of declination can be 
found on the internet1. This will be expressed as either a Easterly or 
Westerly declination, depending on your location. 
 
The date-time, latitude and magnetic field vector should be noted at 
release and recapture point.  That information can be put in the SeaStar 
software under ‘Edit – Reconvert Definitions – Deploy/Retrieve Location’. 
To correct/improve the tilt and magnetic field calculations the user should 
enable that option.  This will give more accurate compass and tilt data. 

                                                 
1 The declination value can be found at www.ngdc.noaa.gov/geomagmodels/struts/calcIGRFWMM 
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5. Using DST comp-tilt - Tutorial 
 
 
This chapter guides users in 8 quick steps through the process of utilizing 
SeaStar to set up DST comp-tilt prior to recording and data retrieval. 
 
Step 1 - Start Program 
Start SeaStar as described in chapter 1.  Remember to carry out the 
software preparation outlined in chapter 2. 
 
Step 2 - Connect 
Connect the Communication Box as described in chapter 3.  Insert DST 
comp-tilt into the hole in the box, and twist the recorder until the green 
light illuminates on the box. 
 
Step 3 - Connect to the recorder 
Choose the Recorder menu and the Connect command.  A window 
appears with information on the recorder’s mode, example: 
 
         

 

        Figure 5.1  Connecting to the recorder 
 
Press OK.  The Recorder is now on-line, as indicated at the bottom of the 
SeaStar window.   
 
Connection time registration  
Each time SeaStar connects to a Recorder, the PC time and recorder 
time is registered to a binary file, with a CLK extension. This information is 
also saved to a text file with the extension CCT.  
Another text file is created with the extension CCD, containing various 
information, for example on previous connection and time comparisons, 
depending on the status of recorder.  
If a previous CCT file exists and the recorder was in sleep or slumber 
mode, a PC vs. recorder clock comparison is calculated, indicating 
difference in seconds and ppm.  



User’s Manual                SeaStar graphic supporting software 
 

16 

If the recorder was in measurement mode, then a drift calculation is 
performed, based upon PC-time comparison to the recorder’s clock and 
measurement sequence.  
The RIT file contains partly the same information as the CCD file.  
Upon retrieving date from a recorder and converting the data, the last 
measurement retrieved time and the next scheduled measurement time is 
compared to the PC time. The results are added to the CCD file and the 
MIT file.  
Note: If the retrieved number of data does not match the last measured 
number of data, erroneous results are to be expected. 
 
Step 4 - Set new measurement parameters 
(If the recorder has already been set up to record data and you want to 
retrieve data, go directly to step 6).   
 
Choose the Edit menu and the New Measurement Sequence Definition 
command.  The following window appears: 

                   

          Figure 5.2  Measurement sequence definition 
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Select the start time of recordings (date-month-year, hours-minutes).  
Set the sampling interval (hours-minutes-seconds).   
 
With default settings, Temp-Depth (TD) and CompTilt will be recorded at 
each sampling (TD-CompTilt normal).  The user has the option to select 
either TD or CompTilt as a primary sensor.  The objective with this feature 
is to save memory size, increase recording period, and get more data on 
the sensor that is of more interest (primary sensor).  In this case, a 
secondary counter can be defined, which can only be odd numbers.  If for 
example CompTilt is selected as a primary sensor, and the number 3 is 
defined as a secondary counter, then TD will only be recorded every third 
time when CompTilt is recorded, and the majority of the memory is used 
for CompTilt recordings.  If CompTilt is set as primary and secondary 
counter to 0, then it is only making Comp-tilt recordings, even though the 
first recording is always a CompTilt-TD measurement. 
 
If the user wants to program several recorders with the same sampling 
interval and start time, it is recommended to select Multi mode.  By 
choosing Multi mode, the settings are fixed; giving each recorder 
connected to thereafter, the same settings.  The recorders connected to, 
following the first recorder, automatically get the same settings as the first 
recorder.  This saves time in the programming process. For programming 
more than one sampling interval, please refer to chapter 9 ‘Multiple 
Intervals’.  
 
The three buttons Use Template, Use Sequence, and Previous are not 
commonly used, but can be handy when wanting to use a previously 
programmed sequence. To read more about templates see ‘Templates’ in 
chapter 8.  
 
After the settings have been selected, press the OK button. 
 
Step 5 - Start a new measurement sequence 
To set the recorder in Measurement Mode (start recording), choose the 
Recorder menu and Start New Measurement Sequence command.   
A window appears on the screen in order to verify the settings to be 
downloaded into the recorder, example: 
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             Figure 5.3  Start New Measurement Sequence 
 
Press OK and the recorder will be in Measurement Mode. 
 
NMS Calculation  
Upon setting up a NMS the estimated measurement sequence is 
calculated and memory and battery energy usage predicted. The results 
are written to a text file, bearing the recorder name with a NMS extension. 
If a recorder has not been selected then the file bears the recorder type 
name, still the NMS extension.  
The file is placed in the SeaStar\NMS directory.  
An example of the *.NMS file is shown in fig. 5.4 
  

 

                                    Figure 5.4  Results from NMS calculation  
 

When starting the recorder in a NMS, the *.RDT file shows the sequence 
settings, plus information on the sequence time duration and battery 
usage (same as in the *NMS file). 
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Step 6 - Retrieve data 
Choose the Recorder menu and the Retrieve Data command.  Data will 
be uploaded from the recorder and presented in graphical and tabular 
form.  With default settings, SeaStar automatically creates a sub-
directory in the Seastar directory, named DST comp-tilt.  In the DST 
comp-tilt directory, a directory named after the recorder’s serial number 
(Qnnnn) is created.  All files related to the recorder are automatically 
saved in the serial number directory.  The default data directory can be 
viewed in the Settings menu, and Directories.  The user has the option to 
define a new data directory path if desired. 
 
The data is retrieved in a non-destructive manner.  This means that you 
can repeatedly read the data without erasing it from the memory.  Each 
time data is retrieved, a new file will automatically be created.  The name 
of the data file consists of the measurement sequence number and the 
serial number of the recorder.  The recorder cannot be loaded with new 
settings if it contains data that has not been retrieved.  This is a safety 
feature which prevents data from being accidentally lost.  New recordings 
overwrite previous recordings that have been retrieved. 
 
Step 7 - Disconnect 
After the recorder has been set up for measuring, it should be removed 
from the Communication Box.  If the recorder is not put in measurement 
mode, it will automatically go into sleep mode when removed from the 
box. 
If you simply remove the tag SeaStar will still have the recorder in on-line 
mode in the program and won’t allow selecting another recorder or using 
certain options.  Select Recorder > Disconnect to go into off-line mode. 
 
Step 8 – View data 
If data is retrieved from the recorder, a new file will automatically be 
created and opened in graphical and tabular form.  To open existing data 
files on the computer, choose the File menu, Select Recorder command, 
and then the Select Measurement command.  When a data file has been 
opened, a new window appears with the data shown as a chart and a 
table.  The next chapter will describe in detail how to view and process 
data. 
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6. View Data 
 
This chapter describes how to open a data file and the options available in 
SeaStar for viewing the data. 
 
Open Data 
 
To open an existing data file that has already been retrieved, do the 
following: 
1. Choose the File menu and the Select Recorder command.  When a 
recorder has been selected, its serial number will be displayed in the blue 
top bar of the software.   
2. Select the data file by choosing the File menu and the Select 
Measurement command.   
 
The name of the data file consists of the measurement sequence number 
(number of times the recorder has been set up to measure) plus the serial 
number of the recorder.  The ‘Measurement sequence no.’ can also be 
seen at the bottom in the SeaStar window.  When the data file (.mid) has 
been selected, the chart and data tables are opened.  The following figure 
shows a chart and data table which have been opened: 

 

 
       Figure 6.1  Chart and data tables of an open file 
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Import 
 
Data files from other recorders than DST can be imported into SeaStar 
and viewed as charts and tables.  The imported file must be a text file with 
the extension DAT, and with SeaStar’s conventional DAT file structure.  
See more about data files and headers in the Appendix. 
 
Buttons 
 
When the chart is opened, buttons related to the chart are displayed.   
 

 
Active Series List 
This button can be useful when working with a multi-sensor recorder, in 
order to select which parameters to display in the chart.   
 

  
Horizontal/Vertical Gridlines 
These two buttons give the option of hiding/displaying the 
horizontal/vertical gridlines in the chart.   
 

 
Data Point Marker 
This button gives the option of displaying/hiding data points in the chart. 
 

 
Histogram 
The graph can be shown as histogram, showing various data statistics. 
 

 
Save Window Data 
Retrieved data is automatically saved, but if changes are made with the 
graph, for example with the time scale, the save button enables the user to 
save the graph (as a DAT file). 
 

 
Print 
The chart can be printed.  Please see chapter 7 for more details. 
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Chart Edit 
By clicking this button, the following window appears: 
 

 

Figure 6.2  Editing Chart 
 
This button gives several options regarding the look of the graph. The axis 
can be defined (max. and min.), titles and legend can be set visible. Under 
‘Panel’ the color of background, borders and gradient can be selected.  
Under ‘Walls - Back’ the colors and gradient of the graph itself can be 
selected.  The ‘Visible’ option must be enabled to activate the features. 
The graph can be exported in formats as jpg, gif, bitmap, metafile, pdf, htm 
and svg. 
 

 
Templates 
If the changes have been made to the graph under ‘Chart Edit’, it is 
possible to save that template. It is also possible to load a previously 
saved template. 
 

 
Hide/Show table 
The data table can be either displayed or hidden using this option. 
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Using the mouse 
 
Max. and min. values 
Click once on any line in the chart, and the maximum and minimum values 
for that line (sensor) are now shown.  A straight vertical line should be 
visible in the graph (to the left).  By clicking on this line and holding the left 
button on your mouse down, the line can be dragged through the chart 
and the data table will scroll along with the position of the line.     
 
Zoom 
The chart can be zoomed in by holding down the left button of the mouse, 
and using the cursor to create a box to the right, around the desired area 
to zoom in on.   
 
Scroll the chart 
The chart can be scrolled upward, downwards and to the sides, by 
holding down the right button of the mouse and moving the cursor in the 
desired direction.   
 
Go back to initial view 
To go back to the initial view of the chart, simply hold down the left button 
of the mouse and make a box to the left with the cursor.  The position of 
the box on the chart is irrelevant. 
 
Change the axis 
By double clicking on the X and Y-axis, the measurement time and 
temperature/depth range can be changed. 
 
Change the title 
To change the title of the chart, double click on the title of the chart 
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The View Menu 
 
When a recorder has been selected, the files in the View menu can be 
opened.  
  
 
Data Trend and Table 
This view is automatically selected when data is retrieved or a data file is 
opened.  If the chart is closed, but a recorder has been selected, this 
command can be selected to view the chart.  The software will open the 
latest chart that was viewed for that recorder. 
 
 
Recorder Information (RIT) 
This is a text file containing basic information about the recorder, serial 
number, production date, estimated battery life etc. 
 
 

Recorder Calibration Information (RCI) 
This text file contains information about the calibration constants of the 
recorder, calibration range of the parameters.  The range is both showed 
as decimal values (DV) and unit values (UV).  The survival depth of the 
recorder is also shown. 
 
 
Recorder Download Information (RDT) 
This text file contains information about the measurement sequence that 
was last downloaded into the recorder, including the start time, sampling 
interval and the measurement sequence number. 
 
Viewing text files  
Under <View\Text files> the user can select a text file, via a file browser, 
for viewing.  
This option is meant to give the (advanced) user a chance to view files 
that are not directly supported for viewing in SeaStar, but are a part of the 
SeaStar documentation system.  
The files that the file browser accepts must have the following extensions:  

• TXT  
Frequently, users copy SeaStar data to text processors and 
spreadsheets, like Word and Excel, and later save the data as TXT 
files for viewing in other applications.  
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• INI  
There are a number of INI files that SeaStar uses for store settings. 
These files are described in the Appendix under ‘Information files’. 
The latest members in the INI files family are the Template files.  

• DAD  
This is the original data file. It contains the raw data (in Ascii format) 
retrieved from recorder. The DAD together with the MID are 
converted to the DAT file.  
A word of warning: The DAD file should never be tempered with, as 
that might give cause to erroneous data conversion.  

• CCT  
Every time SeaStar connects to a recorder, the PC time and the 
recorder’s clock data are stored in a <recorder name>.CCT file.  

• CCD  
Every time SeaStar connects to a recorder, the PC time and the 
recorder’s time are compared to the last CCT, if found, and stored 
in <recorder name>.CCD file, <measurement sequence 
name>.CCD.  

• NMS  
Upon completion of a NMS editing session, estimation of memory 
and battery usage is calculated and the results placed in a NMS file, 
which is then displayed to the user.  

 
 
SNMS LOG file 
To improve the “Start New Measurement Sequence”, SNMS, 
indication/registration of success or failure, a log file for each recorder 
type is placed in the SeaStar directory. 
The log file name, for DST comp-tilt, is DSTI.LOG, i.e. the same naming 
convention as for the type INI files. 
Each time a SNMS is performed then the appropriate LOG file is updated. 
The LOG file can be viewed via “View\SNMS Log file (LOG)”                                                      
In addition to the LOG file, if an error occurs during the SNMS, the MDD 
file is created as a text file, with a description of what went wrong. This 
MDD file is displayed as a clear message for the user as shown in figure 
5.6. 
Usually the MDD file is a binary file, and the MDT is created from the 
MDD. If the SNMS is repeated successfully the MDD file is overwritten 
and the MDT file created. 
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Figure 6.3   The MDD SMNS error message 
     

 
Measurement Data 
Measurement Download Information (MDT) 
This text file contains information on data downloaded into the recorder 
for the measurement file being viewed, including the start time and 
sampling interval. 
 
Measurement Information (MIT) 
This text file contains information concerning the measurement upload 
time, start date, start time and number of measurements in the 
measurement data file. 
 
Conversion Information (CIT) 
This text file contains conversion information on the units and the data file 
format. 
 
Statistics in CIT: 
The CIT, has been enhanced with more detailed information on the 
converted data. 
 
As can been seen in figure 6.4, the statistical data, that have been 
tabulated, are split into two sections, the Unit values statistics and the 
Decimal value statistics.  Values are given for each parameter. The file can 
be viewed under ‘View\Measurement Data\Conversion Information (CIT)’: 
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       Figure 6.4  Statistics in CIT file 
 
A one line description/comment is available for the user to fill out in the 
Reconvert data menu. This description is placed in line two of the CIT file. 
 
Out Of Range (OOR) 
This text file lists all the measurements that were outside decimal value 
calibration range, as well as the unit value range.  If correction has been 
performed according to the user definition, then the corrected values are 
shown.  See more about ‘out of range’ in chapter 8. 
 
Binary Data (DAB) 
This file contains raw data of the measurements in the data file.  
Calibration files are not calculated into the data. 
 
View DAB files as trend 
When converting the DAD -> DAT the DAB file is created simultaneously.   
The DAB shows the recorder’s native data, i.e. decimal values in the range 
0-4095. These values originate from the recorders 12 bit ADC (Analog to 
Digital Converter). 
It can be of interest to view the data in its native form, for example to spot 
saturation/out of range intervals. 
 
The DAB can be viewed graphically as a trend via: 
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‘View\Data Trend and Table\Decimal (Binary) data (DAB)’ 
 

 

Figure 6.5  DAB trended 
 
SeaStar cannot view older DAB files, and will inform the user to that 
effect, if an attempt to view an older DAB file is performed.  By 
reconverting the data, a viewable file is produced. 
 
Converted Data (DAT) 
This is the text file for the converted data.  The DAT file as well as the 
other text files can be opened in other programs (Excel, Notepad, Word 
etc.). 
 
Time Synchrone Data (TSD) and Rate of Change (ROC) 
If the TSD and/or ROC file creation has been enabled under the Settings 
menu, then it’s possible to view these files. More about TSD and ROC in 
chapter 8. 
 
More about files in the ‘Appendix’.  
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Opening data in Excel 
 
When retrieving data, the SeaStar software automatically creates a text 
file with the data, called *.DAT.  This text file can be opened in Excel and 
in other programs. 
 
Under the ‘Settings’ menu, ‘Preferences – Data File Format’, the default 
factory settings is set to ‘joined date and time’.  If this option is not 
disabled, the following is performed, for opening data in Excel: 
1. Excel is started. 
2. The *.dat file is found from ‘File/Open’. 
3. Excel comes up with the ‘Text import wizard’.  This is a three step 
process: 

a) No changes should be made in first step, so hit the next button. 
b) ‘Text qualifier’ should be set as ‘None’.  Hit the next button. 
c) Column 2, that is date and time, is set as ‘Text’.  Hit the finish 

button. 
4. You can now create the graph with columns B, C and D.  
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7. Printing 
 
All charts and text files can be printed from the SeaStar software.  
Choose the File menu and the Print command.  If a chart is in the active 
window, the following dialog box appears: 
 

 

Figure 7.1  Print dialog box 
 
Orientation 
The chart can be printed in either portrait or landscape format. 
 
Margins 
By changing the margins, the chart’s length and width can be re-scaled.  
The margins can be varied by either changing the numbers given for the 
left, right, top and bottom margins, or by moving the margin lines with the 
mouse by pressing and holding the left button as the lines are dragged. 
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Move 
When the cursor is located on the chart, a hand becomes visible.  By 
clicking on the graph and holding down the left button of the mouse, the 
graph can be moved around the page to a desired position.   
 
Detail 
The size of horizontal and vertical gridlines as well as the texts on the X 
and Y-axis can be re-scaled by using the scroll bar.  The number of 
gridlines is increased when the bar is moved to the left.   
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8. Settings 
 
This chapter describes the options in the Settings menu.  These settings 
are automatically saved when exiting the program. 
 
Directories 
 
The path definition can be set as Default SeaStar path structure or User 
defined paths.  Choose the Settings menu and the Directories 
command.  A dialog box appears: 
 

 

Figure 8.1  Directory path definition 
 
Default SeaStar path structure 
By choosing DST comp-tilt as a recorder type, SeaStar automatically 
creates a ‘DST comp-tilt’ type directory in the ‘SeaStar’ directory that was 
created when the software was installed on the computer.  Upon 
connection with DST comp-tilt, another directory is automatically created 
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in the ‘DST comp-tilt’ directory, which is named after the serial number of 
the recorder.   
 
All data files and other files related to that recorder are stored in this 
‘serial number’ directory.  Each DST comp-tilt recorder has its own data 
directory.   
 
User defined paths 
If this option is selected, the User definition data directory becomes 
active.  The data path/directory can be defined by the user.  For defining a 
path on the network, the particular drive must be mapped (under 
Windows Explorer) in order to browse for the drive under ‘Add data path’. 
 
Browse first in user directory 
With default off, the user is first directed to the path where SeaStar was 
installed, to look for the INI file.  If this option is enabled, SeaStar will start 
looking for the INI file in the user-defined directory.  More information on 
files and directories can be found in the Appendix. 
 
Create recorder directories 
This option is default on, and means that a recorder type and serial 
number directory is created for every recorder connected to. 
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Preferences 
 
Units 
By choosing the Settings menu, the Preferences command, and Units, a 
dialog box appears: 

 

       
       Figure 8.2  The units dialog box 

 
Select units 
The user defines whether degrees Celsius or Fahrenheit are used as a 
unit for temperature measurements.  The pressure measurements can be 
displayed as pressure (bar), depth (m), fathom (fthm) or PSI.  Number of 
decimals for the values can be selected. The comp-tilt heading is default 
set to 4 point comp-tilt (N-E-S-W) but also possible to increase it to 8 or 
16 point comp-tilt. 
 
Data File Format 
By choosing the Settings menu, the Preferences command, and Data 
File Format, a dialog box appears: 
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     Figure 8.3  Data file format dialog box 
 
Date format 
The user defines whether the date should be shown as dd mm yy (day, 
month, year), or mm dd yy (month, day, year). 
 
Date separation 
The user defines whether a dot, slash or dash should be used to separate 
the date. 
 
Time separation 
The user defines whether a colon or a dot should be used for the time 
separation. 
 
Field separation 
For the text files created, the user defines whether a tab or a space should 
be used to separate the fields. 
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Date and time column definition 
If data is to be exported to other programs, it is recommended that the 
date and time be joined in one column. 
Select decimal point 
The user defines whether a comma or period is used for the values 
displayed in SeaStar and for text files that are created.   
 
Measurement Interval 
 
The default setting in the software is set to ‘Single interval’, as most users 
utilize.  By choosing ‘Multiple intervals’ the software enables programming 
of several different sampling intervals, enabling memory saving efficiency.  
By choosing the Settings menu, the Preferences command, and then 
Sampling Intervals, the following dialog box appears: 
 

      

     Figure 8.4  Measurement intervals 
 
 
By choosing ‘Multiple intervals’ the effects are shown in the dialog box 
that appears when you choose the New Measurement Sequence 
Definition command under the Edit menu.  More details about multiple 
intervals in chapter 9.   
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Connection 
 
Choose the Settings menu and the Connection command.  A dialog box 
appears: 

 
Figure 8.5   Connect and retrieve data options 

 
 
Perform CRC test when retrieving RID 
The CRC test is a safety check performed by the software when retrieving 
Recorder Information Data (RID).  If the CRC test is not successfully 
carried out, it means that some errors have occurred in the transfer of files 
or constants, between the recorder and the computer.  If a CRC test 
failure occurs, the user is notified.  This option is enabled by default but if 
disabled there is a risk of errors in the constants. 
 
Automatic data retrieval upon connection 
By enabling this option, the software will automatically check for data in 
the recorder upon connection.  If this option is not enabled, data retrieval 
is done manually by choosing the ‘File’ menu, and ‘Retrieve Data’ 
command. 
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Retrieve Data 
 
Choose the Settings menu and the Retrieve Data command.  A dialog 
box appears: 
 

 

Figure 8.6  Retrieve Data Options 
 
Retrieve number of data 
With default settings, the software retrieves the last measurement 
sequence recorded.  The user has the option of retrieving older data that 
is still in the recorder’s memory.  By choosing the User defined number 
of data, the number of measurements retrieved from the recorder can be 
set.  Memory capacity is 20,120 measurements per sensor compass, 3-D 
tilt, depth and temperature (261,575 bytes).  When retrieving data, it is 
optional to view the Data Trend after conversion. 
 
As the complexity of measurement intervals give incoherence in the 
calculation from measurement number to the number of data byte to 
retrieve, the user has the option to define number of bytes to retrieve. 
 
Also when not online working with measurement data, it is optional to 
view the Data Trend after a Sequence Selection. 
 
If for some reason or another it becomes necessary to retrieve data more 
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than once or even several times, the previous DAD and MIT files are not 
overwritten before a backup has been made. The backup files are in the 
same directory as the “original” or the last DAD file.   
 
A backup number system is in use that marks the first retrieved file as 
number one, the second number two etc.  The number sign #, is used to 
identify the backup up files. 
 
Thus if a data file has for example the name 25M1106.DAD then the 
backup file, that was the first retrieval, gets the name 1#25M1106.DAD, 
and the 25M1106.MIT file that is associated with the DAD file, is backed 
up as 1#25M1106.MIT.   
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ReConversion 
 
Choose the Settings menu and the ReConversion command.  A dialog 
box appears: 

 

Figure 8.7  Reconvert menu 
 
With all the options in SeaStar, the user may want to do a lot of 
reconverting (<File\Reconvert Data>) on data files after defining the 
preferences; changing units, data formats, OOR settings, TSD settings, 
ROC settings, offset settings and converting different sections of the data 
file, all of which result in numerous files. To ease the task of remembering 
settings and results and/or renaming and copying files, a backup system 
of reconverted files has been implemented. 
 
A reconvert number is now associated with each sequence. This number 
is saved in the recorder’s INI file and updated each time a reconvert is 
implemented.  A copy is made of the DAT, CIT, DAB, OOR, TSD and the 
ROC files with the reconvert number attached to the filename. 
 
Thus if a data file is for example named 5Q1024.DAT, then after the first 
reconvert, a copy of the DAT is named 1-5Q1024.DAT, and the same 
naming convention is applied to the other files. 
 
Each time data retrieval is performed, a subdirectory, which name is the 
sequence number, is created in the data directory, where a copy of the 
“original” DAT, DAB, CIT and OOR files is placed.  These files have a “0-“ 
in their names. All the reconverted files are placed in the sequence 
directory. The reconvert number system is optional, and the user can 
disable it in the reconvert menu. When the reconvert number system is in 
use, and when viewing trended reconverted data, the reconverted 
“backup” file is displayed, thus eliminating the need to close the “last” 
converted trend data window. 
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Out Of Range 
 
If measurements are outside the calibrated range, they are less accurate.  
The out of range measurements (if any) are shown in the OOR file (View – 
Measurement Data – Out Of Range Data). For example when depth 
measurements are outside the first calibration range (at very shallow 
depth or in air) the data may look strange and the user may want to set 
those data to 0.  
 
Choose the Settings menu, Out Of Range - UV and DV definition 
command.  A dialog box appears: 
 

 

Figure 8.8  Set ranges for the parameters 
 
The Unit Values (UV) ranges can be set, eliminating all values that are 
outside the calibration range.   
 
Decimal values 
Decimal Values (DV) are raw measurements, sometimes referred to as 
binary data.  The decimal value is between 0 and 4095, which is the 
range for the 12 bit AD converter.  The decimal values are the recorder’s 
calibration range.  The user should not define the decimal value range, 
unless he has obtained these values for that particular recorder from Star-
Oddi.   
 
Unit values 
The decimal values are converted to Unit Values (UV), for example a 
decimal value of 2000 could give 20°C.  The user can select a specified 
range for the parameters.  If unit values in the data are outside the 
measurement calibration range of the recorder, the user has the option to 
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set a max. and min. range for these unit values.  After selecting the unit 
value ranges and pressing the OK button, the following window appears: 
 

 

         Figure 8.9  Out Of Range (OOR) Correction 
 
If no values have been selected for the Decimal Value (DV), ‘No 
Correction’ should be selected for ‘DV-Correction’.  If Unit Values (UV) 
ranges were specified, the user has two options: 

1. Last Value: Change the out of range measurements to the last 
value that was recorded before the out of range measurement was 
recorded 

2. Max/Min UV-limits: Change the out of range value to the max/min 
unit value as specified earlier.  In this case the software will know if 
the value is under the minimum or maximum limit.   

 
After the correction has been made (after pressing OK), the data needs to 
be reconverted under ‘File – Reconvert Data’, and data will be changed 
accordingly.  More about reconverting in chapter 11.   
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Time Synchronous Data (TSD) 
 
Choose the Settings menu, TSD definition command.  A dialog box 
appears: 
 

 

Figure 8.10  Time Synchronous Data Settings 
 
If the user wants to time synchronize two or more data files, it is possible 
to select three options: 1 hour, 10 minutes, or 5 minutes.  The restriction 
is that the sampling interval selected must be greater than the initial 
interval, and it must also be dividable by the initial interval.  For example, if 
the initial interval was 15 minutes, only the 1 hour option can be selected 
for time synchronous. 
 
If the ‘Include empty cells’ is enabled, the data tables will be empty for 
those measurements in the original file that are not to be shown.   
 
If the user wants to activate this feature, the ‘Make TSD file when 
converting DAD-DAT’ must be enabled.  For changing the current 
measurement file with one of the three intervals, the data must be 
reconverted by ‘File – Reconvert Data’.   
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Rate Of Change (ROC) 
 
This new feature gives the user a chance to see how fast the signal is 
changing, i.e. the estimated velocity of the signal.  This applies to all 
measured parameters.  The ROC is calculated via a two point numerical 
differentiation: 
 

ROC= (P2-P2)/(t2-t1) 
P: Parameter expressed in a user defined unit 
t: Time  (hour, minute or second) 

 
The way the ROC is set up and viewed is very similar to the TSD. 
Under ‘Settings\ROC’ the ROC options can be set: 
 

 

          Figure 8.11  ROC definition 
 
The ROC is only computed when a DAD->DAT conversion is performed, 
and when the user wishes. The time units are selectable as hour, minute 
or seconds.  For small changes it can be convenient to express the ROC 
as a milli (10-3) unit, for example if the depth is in meters (m) then 
millimeters are expressed as (mm). 
 
The ROC can be viewed as a trend under ‘View\Data Trend and 
Table\Rate Of Change (ROC)’ or as tabulated data via 
‘View\Measurement Data\Rate Of Change’. 



User’s Manual                SeaStar graphic supporting software 
 

46 

Chart 
 
Title 
 
To change the title of the chart click on the title name.  A dialog box 
appears: 

 

       Figure 8.12  Chart title dialog box 
 
The chart is automatically assigned the data file number as a chart title.  
To change the chart title, enter a new text string and press the OK button. 
 
 
Time axis 
 
To change the time scale of the chart, click on the X-axis scale.  A dialog  
box  appears: 

 

               Figure 8.13  X-Axis settings dialog box 
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By disabling the Automatic option, the minimum and maximum time values 
become active.  By clicking on the Change buttons for the maximum and 
minimum values, the time range can be specified.  For creating (saving) a 
new data file (DAT) with a new specified time scale, please refer to 
chapter 11 (Reconvert).  By enabling the Automatic option, the 
measurement time will go back to the  initial range. 
 
 
Value axis 
 
To change the scale settings for the value axis, click on one of the Y-axis 
scale.  A dialog box appears: 

 

 

        Figure 8.14  Y-Axis settings dialog box 
 
By disabling the Automatic option, the minimum and maximum 
measurement values become active.  By clicking on the Change buttons 
for the maximum and minimum values, the range to be shown on the chart 
can be specified.  By enabling the Automatic option, the measurements 
will go back to the initial range.   
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Chart Editor  
 
The Chart Edit button (on every graph) gives access to the Chart Editor, a 
multi-option menu, now with a Tree View interface, as can be seen in 
figure 8.15.  
There are four main branches on the tree.  
 

1. Series  
2. Chart  
3. Data  
4. Export  

 
The tree menu gives access to the same features as the tab menu 
described in the user’s manual. Most of the changes invoked are viewable 
immediately.  
All format and style changes made to the chart, are lost if the data are 
viewed again or “Reconverted”, as the *.DAD and the *.DAT file are not 
affected by changes made to the chart or the database.  
 
1. Series:  
The Series window offers the same features as the “Active Series List” 
button.  
 

 

Figure 8.15  Chart Editor  
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When a particular series is selected, like the Temperature series for 
example, a two tab menu is revealed, as seen in fig. 8.16, where the user 
can “format” each series, and set “points” in the graph. The tab “Point” 

offers visibility to points as the “Data Point Marker” button on the graph, 
plus formatting of the points.  
 
 

Figure 8.16  Format series.  
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2. Chart  
The chart branch has six sub branches,  

• Axis  
• Titles  
• Legend  
• Panel  
• Paging  
• Walls  

 
Axis:  
There are 8 axes in a normal SeaStar chart, the number in use depends 
on the recorder type. The Left Axis and Custom 1 axis are always in use, 
the latter is reserved for the timeline.  
 

 

Figure 8.17  Axis formatting 
 
Figure 8.17 shows a six tab Axis menu. There are numerous options, 
some of which can drastically change the behavior of the graph. The 
Minimum and Maximum tabs give options similar to the menu offered 
when clicking an axis on the graph, the ticks tab gives access to enable 
and disable gridlines, just as in the “Horizontal gridline” and “Vertical 
gridline” buttons in the graph.  
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Titles:  
The Titles menu shown in figure 8.18, gives access to 4 tiles, each title a 
multi line text window, which can be positioned anywhere on the chart. 
There are multiple formatting options, six tabs, for each title.  

 

Figure 8.18 Titles menu 
 
Legend:  
The legend menu (see figure 8.19) gives the user an option of showing a 
series legend.  
The 8 tab menu gives options in styling positioning and formatting the 
legend.  

 

Figure 8.19 Legend menu  
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Panel:  
The Panel menu (see figure 8.20) offers panel format options. Images, 
pictures and icons can be imported onto the panel as a back image.  

 

Figure 8.20 Panel menu 
Paging:  
With the Paging menu, shown in figure 8.21, the data series can be 
chopped into pages, with a user defined number of points per page. Only 
one page is shown at a time, and the user can scroll through the pages 
via the page buttons, that appear (are enabled) on the chart to the right of 
the Edit Chart button, when paging is selected.  
Paging can be useful for viewing distinct time periods, one at a time, days 
or hours for example. No offset is offered and sampling periods and start 
time can limit the usefulness of this option.  

                                            
                     Figure 8.21  Paging menu  
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Walls:  

 

Figure 8.22  Walls  menu  
 
The walls menu, as seen in figure 8.22, gives access to configuration of 
four walls, but as SeaStar charts are default defined as 2D, only the 
“Back” wall is visible.  
The Walls menu, has similar options as the Panel menu, when defining a 
pattern, via the “Pattern…” button, as seen in figure 8.22, an image can 
be imported and placed on the wall. In fact, as the Back Wall lies “on top” 
off the panel, a pattern or an image can enhance an image on the panel, 
or the image on the panel can be seen through the wall with the 
Transparency option.  
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3. Data  
In the data menu, seen in Figure 8.23, gives the user access to the 
database, upon which the chart rests. Here text labels can be set to each 
measurement point. Changes can be made to the time and measurement 
values. Changes made to the data, are included when the data is 
exported, but if the data are viewed again or “Reconverted” all changes 
are lost, as the *.DAD and the *.DAT file are not affected by changes 
made to the database.  

 

Figure 8.23  Data menu. 
4. Tools 
Under 'Tools' you will find several options to customize the setting of the 
cursor and the appearance of the graph, such as page numbering, font, 
font size etc. To active/deactivate the chosen setting check/uncheck the 
'Active' box on top of the first page of this menu. 

 

                                   Figure 8.24  First page of Tools menu 
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5. Export  
Under the Export menu, three tabs offer as many menus for saving data as  

• Pictures.  
• Native (data)  
• Data (file)  

 
Pictures  

 

                                      Figure 8.25  Export menu: Picture 
 
Figure 8.25 shows options when saving the chart as a picture to a file, or 
copy the picture to the clipboard. There are seven format possibilities.  
 

• Metafile  

• Bitmap  

• JPEG  

• GIF  

• PDF  

• VML  

• SVG  
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Native  
The Native menu, see figure 8.26, data is saved as “Native” *.tee chart 
files. Import of these files is not supported in SeaStar at the moment.  
 

 

Figure 8.26  Export menu: Native  
Data  
Data can be exported to files in four formats, see figure 8.27.  

• Text file (.txt)  
• XML (.xml)  
• HTML (.hml)  
• Excel (.xls)  

 

     Figure 8.27  Export menu: Data  
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There are four Include options:  
Point Index:  
The point index is the same as the measurement number, but offset by -1, 
as it starts in 0 instead of 1.  
Point Labels.  
If the user has added text labels to points in the DATA menu, these can 
be included.  
Header  
The same headers as are in the DATA menu.  
Point Colors.  
This option is not relevant in SeaStar. 
 
Another method for exporting is to use the Alt+PrintScreen keyboard 
buttons to copy an image of the SeaStar window to the clipboard, 
thereafter to paste it to another Windows application.  When a dialog box 
is open, then only that frame is copied to the clipboard. 
 
To copy a part of a data file, for example from a DAT file, then highlight the 
part you want to copy and use the Ctrl+C keyboard buttons to copy  the 
data snippet to the clipboard. Then use the paste-option in another 
Windows application to transfer the data from the clipboard. 

 

Figure 8.28  Highlighted text to be copied 
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Timeline  
 
The timeline is a graphical viewing aide. Every time a file is loaded for 
trending, an extra time value is calculated for every measurement point. 
These time values form the Timeline. The Timeline is an extra series that 
follows the rules of the other measurement series. When the graph first 
appears, the Timeline is inactive.  
By selecting the Timeline in the Series List (see fig. 8.29), the Timeline 
becomes visible as shown in figure 8.30.  
 

 

          Figure 8.29  Timeline selection  
 

 

 
Figure 8.30 Timeline on a graph showing “Day of the year”  
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The Timeline is defined under Settings\Preferences\Timeline.  
There are several options for the Timeline, as can be seen in fig. 8.31.  
 

 

Figure 8.31  Timeline options.  
 
There is no need to reconvert the data, as every time a data file is loaded, 
the Timeline is calculated in accordance with Timeline settings. The 
Timeline is not a part of the *:DAT or the *.TSD files, but if the data is 
exported (see the Export section), then the Timeline, if selected, will be 
included. Thus, the Timeline can also be used for statistical purposes. 
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Templates  
 
There are two scenarios where templates come in handy:  

1. When many recorders are programmed with the same settings 
(multi mode), and circumstances are in a way that the user cannot 
complete the setup of all the recorders in one session, and he has 
to exit SeaStar (to continue later).  

2. When the user wants to reuse, partly or completely, presumably a 
complex and/or lengthy measurement setting.  

 
Save a template  
The user can now, when editing New Measurement Settings (NMS), save 
his work by enabling “Save this NMS as a Template (file)” option (see fig. 
8.32), before acknowledging OK from the Edit NMS menu. Having 
selected this option and the NMS are OK, the user has an option to write 
a description for the template (see fig. 8.33). Canceling this option 
cancels the ‘save template’ operation. The template is an INI file and 
saved in the SeaStar\NMS directory. The name of the file is 
MST<date><type letter>time<Interval mode>.INI.  
 

    
   Fig. 8.32  Template options in Edit\New Measurement Sequence  
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Figure 8.33  Saving NMS as a Template 
 
Use a template  
Templates can be retrieved at a later time to be used directly or modified. 
The list of templates is kept in the SeaStar\templets.ini file.  
As can be seen in fig. 8.32 there are three buttons in the Edit NMS 
window, the top button is used for retrieving a template.  
As can be seen in fig. 8.34, templates are selected via template name or 
description. Parallel to selecting a template, descriptions can be edited 
and eventually templates deleted.  
The recorder type and interval type, which the template was based on, are 
visible for each template.  

 

Figure 8.34  Template selection  
 
Templates can be used across recorder type boundaries and interval 
types.  
Things to keep in mind when selecting a template are:  

• Single interval templates converted to a multiple interval NMS. All 
seven intervals are the same.  

• Multiple interval templates converted to a single interval NMS, set the 
interval as interval one.  
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• Start time in the past is not allowed as will be apparent when exiting 
the Edit NMS window.  

• Some recorder types are less compatible than others, an example of 
that is a DST milli template converted to a DST GPS NMS.  

 
After having selected a template the user is returned to the edit window. If 
the selection is not as what the user expected the “Previous” button will 
return the previous setting.  
 
The user has one more option to quickly set up the NMS. The button in 
fig. 1, marked “Use Default”, will return default NMS settings. The button 
can have four descriptions and return four different settings depending on 
the status of recorder and measurement selection.  

1. Use Default: No recorder selected  
2. Use Recorder: Recorder selected but not a measurement sequence  
3. Use Sequence: Measurement sequence selected  
4. Use Online: Recorder is on-line  
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9. Multiple Intervals 
 
 
SeaStar has the option for setting up more than one sampling interval 
within a measurement sequence.  Reasons for wanting multiple intervals 
can be to save memory, but still be able to have frequent measurements in 
between.  This may be the case with fish tagging, when frequent 
recording is wanted in a specific period in the fish life cycle.  If you want 
to run on a single interval the whole recording period, this option is not 
selected. 
 
By choosing Multiple Intervals (under Settings-Preferences-
Measurement Intervals), multiple interval setup is activated.  Thereafter, 
choose the Edit menu and New Measurement Sequence Definition 
command.  The following dialog box appears: 
 

 

Figure 9.1  Set new measurement sequence (with multiple intervals) 
 
Start time 
The user defines the date and time when recordings should start.   
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Measurement interval 
The sampling interval (time between measurements) is defined.  Any value 
from 1 to 99 seconds, or 1 minute to 24 hours with increments of 1 
minute.  Up to 7 different sampling intervals can be selected.  If seconds 
are used as sampling interval, the multiple of the sampling interval and the 
number of measurements must be dividable by 60. 

 
Number of measurements N1-N7 
The user defines the number of measurements to be recorded within each 
sampling interval.  A value from 1 to 60000 must be set.  Please note that 
an inital measurement is taken at the defined ‘start time’.  This initial 
recording is not counted as a measurement for the ‘Interval 1’ number of 
measurments.  For example if the recorder should measure every hour 
from midnight to ten o’clock (00:00 – 10:00), then the number of 
measurements defined should be 10.    Please note that only this one 
measurement at the ‘start time’ does not count as a measurement for the 
intervals.  In this case, the first measurement counted for the ‘Interval 1’ is 
at 01:00, and the last measurement is at 10:00, and then it shifts to 
another interval. 
 
After taking one measurement at the ‘start time’, the recorder will start on 
the first interval in the sequence and take the number of measurements as 
defined.  After taking the measurements on the first interval, it will 
automatically shift to the next interval etc.  The sampling intervals and 
number of measurements will recycle until memory is full, or until 
connection is made with the recorder through a PC computer. 
 

 
Sequence 1-14 
The interval sequence must be filled out.  As shown in figure 10.1, the 
user selects to use intervals 1-6 for the recordings.  Another example:  
If two of the first sampling intervals are used, the sequence should be 1, 
2, 1, 2 etc., meaning that the recordings shift between the first and the 
second intervals, recording the defined number of measurement for the 
first interval, and then shifting to the second interval taking the number of 
measurements defined.  The shifting between the intervals repeats until 
memory is full, or until connection is made through a PC computer.   
 
Primary/Secondary 
With default setting, both Temperature-Depth (TD) and CompTilt is 
recorded at each sampling interval (TD-CompTilt normal).  The user has 
the option to select either TD or CompTilt as a primary sensor for each 
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sampling interval.  The objective with this feature is to save memory size, 
increase recording period, and get more data on the sensor that is of 
more interest (primary sensor). 
 
The secondary counter  is only meaningful if a primary parameter has 
been selected. The secondary counter defines how frequently the 
secondary parameter is saved along with the primary parameter.  If for 
example Comp-tilt is selected as a primary sensor, and the number 3 is 
defined as a secondary counter, the TD will only be recorded every third 
time when CompTilt is recorded.  If the value is 0 (zero), the recorder is in 
principle a Comp-tilt only, except the first measurement is always a TD-
CompTilt measurement. 
 
There are restrictions on the secondary counter settings when multiple 
intervals are defined.  If a primary parameter is selected and secondary 
counter is 0 then the ‘Number of meas.’ for the primary counter must be 
an even number.  If a primary parameter is selected then the ‘Number of 
meas.’ must be dividable by the secondary counter, and only odd numbers 
(0,3,5,7...255) can be used as a secondary counter.  
 
The Use Template can be used if older definitions have been saved by 
enabling the ‘Save this NMS as a template (file)’. That way it’s possible to 
get templates that have been set up in the past. With the Use Sequence 
button it is possible to get same settings as from other recorders, by 
browsing for their serial no. By hitting the Previous button the settings go 
back to previous, before changes were made. 
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10. Reconvert Data 
 
 
In SeaStar you have the option of reconverting data that has already been 
retrieved.  After re-defining parameters, the data is reconverted by ‘File – 
Reconvert Data’.  The main reasons for reconverting data are: 

• Adjust the center point for the pitch and roll 
measurements. 

• Shift pressure/depth values according to a reference 
meter, to increase accuracy. 

• Adjust measurements that are outside calibration range. 
• Incorrect PC-time at measurement start time. 
• Need for temperature or pressure/depth unit alteration. 
• Need for data file format alteration. 

 
 
Data Reconvert Definition 
Under the Edit menu and Reconvert Definition, choose the Data 
Definition command, and the following dialog box appears: 

 

                                   Figure 10.1  Reconvert data definition 
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Set reconversion measurement sequence start-time 
If the user notes from retrieved data that the PC date and clock were 
incorrect when measurements were started, it is possible here to specify a 
new start date and start time.   
 
In reconversion use measurement intervals from 
The measurement interval is either the interval settings as shown in the 
measurement (MID) file, or if that interval is incorrect, a new and correct 
sampling interval is specified in the ‘New Measurement Sequence 
Definition’ command in the ‘Edit’ menu. 
 
In reconversion use constants from 
The user can choose to use calibration constants from: 
MID file.  This option should normally be selected, as it contains 
information on the constants from the measurement sequence. 
RID file.  The recorder information file contains the same calibration 
constants as the MID file, except if it has been re-calibrated.  If it has been 
re-calibrated, and the user wants to use the new constants on older 
measurements, the RID option should be selected.   
RBD file.  This option rarely needs to be selected.  If the constants from 
the MID and RID file are corrupt, the user should contact Star-Oddi for an 
RBD file.   
 
Convert number of data 
The user can reconvert all the data in the last measurement sequence, or 
define the number of measurements to be reconverted.  The user has the 
option to define what measurement range should be reconverted (for 
example to exclude data points when the recorder was above water). 
 
Time linear adjustment 
The real time clock inside the DST has an accuracy of approximately +/- 1 
minute per month. This slight variation might accumulate over time and 
influence the measurement results. To correct the gradual time shift first 
check „linear adjustment time“ then type in the time offset value and the 
length of the measuring period. 
 
Out Of Range Decimal Value Settings 
Measurements that are outside the calibration range are inaccurate, and 
may give erroneous results.  The out of range (OOR) measurements can 
be seen in the OOR file.  The user has the following decimal value out of 
range detection options when reconverting: 
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Full scale (no boundaries).  This means that literally no ‘out of range’ 
detection will be made. 
User definition.  With this selection the range definition under ‘Settings - 
Out Of Range - DV definition’ will be used.  This option is selected when 
the decimal values (DV) are not available in the RID file.  This would 
normally require the user to contact Star-Oddi for the decimal values. 
RID values.  The calibration decimal range is given in the RID file.  This is 
the default option and should normally be selected. 
 
If an RBD file exists in the \Seastar\RBD folder, then SeaStar recognizes 
this file as a primary source for DV calibration range.  In this case, the 
fourth option appears and is set as default. 
 
 
Temperature Definition 
 
Under the Edit menu and Reconvert Definition, choose the Temperature 
Definition command, and the following dialog box appears: 
 

 

                            Figure 10.2  Temperature offset correction menu 
 
Offset Adjustment 
When recorders are used over a long period of time, the temperature 
measurements can start to deviate from correct values.  
When checking older recorders, it has come apparent that the error in the 
measurements is mainly due to an offset. Some users feel they can benefit 
from an offset correction option in SeaStar, for example when a recorder 
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has been in the water for a long time and is later tested to show an offset. 
The offset is defined in m°C∗ (please note that 1°C equals to 1000 m°C).    
 
 
Pressure Definition 
 
Under the Edit menu and Reconvert Definition, choose the Pressure 
Definition command, and the following dialog box appears: 
 

 

Figure 10.3  Pressure reconvertion definition 
 
Disable temperature correction in pressure calculation 
In case the temperature sensor is malfunctioning in a way that it will 
indicate very high temperature values, it will offset the pressure 
calculation. An automatic temperature correction is set by default in 

                                                 
∗ 1000 m°C = 1°C 
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SeaStar. To turn off this feature, check the box next to „Disable 
temperature correction in pressure calculation“. 
 
Pressure offset adjustment 
The user can increase accuracy of pressure/depth recordings by finding 
an offset value, which is the difference between a recorder’s depth value 
and a reference meter’s value.  Once the offset point has been set in, the 
data can be reconverted, and all pressure/depth recordings shifted 
according to the value defined (in mbar).    
 
In cases where a drift has occurred with the pressure recordings, the 
pressure data can be corrected if the user has a known reference point 
for correcting the data.  To find the offset value, the recorder should be 
deployed in water, at a known depth (preferably >2 m depth), or placed 
along with an accurate reference depth meter, where a reference point 
can be taken.  Once the offset value has been found, the offset pressure 
value is put in the window shown above.  The offset value can either be 
subtracted or added to the pressure values.   
 
When using 9.81 as g, the coefficient for converting cm into mbar is 
1.019∗. If the ‘Use at next data retrieval for this recorder’ is enabled, the 
offset value is fixed for that particular recorder, and future data uploads of 
the recorder will use the offset value defined, for shifting the pressure 
data.  The offset value will apply only to that particular recorder, and other 
offset values can be defined for other recorders.   
 
Pressure linear adjustment 
Aging of the pressure sensor can result in an offset of the measured 
pressure values. To correct these offset values you can select a linear 
pressure adjustment. Check „linear adjustment value“ and fill in the 
pressure offset value (difference between expected value and real value at 
the end of the recording period) and the length of the measuring period. 
 
Linear estimation outside calibration range 
The pressure sensor tolerates a significantly higher pressure than its 
calibration range. If the recorder is exposed to higher pressures than its 
calibration limit it will result in erroneous data. By choosing this option you 
will receive more adjusted values. Please note that since these values are 
outside of the calibration range an exact adjustment is not possible, this 
feature is mainly for estimation purposes. 
 
                                                 
∗ For example 100 cm = 101.9 mbar 
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Depth calculation 
For converting the pressure units to depth, the standard for the 
acceleration of gravity is 9.81 (1 bar = 1000 mbar = 9.81 m), but it can 
optionally be set from 9.78 to 9.83, depending on the gravity in the 
different areas of the world.   
 
 
Pitch & Roll Reconvert Definition 
 
Under the Edit menu and Reconvert Definition, choose the Tilt 
Reconvert Definition command and a dialog box appears: 
 

 

Figure 10.4  Pitch & Roll Reconvert Definition 
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As the ‘No angle offset adjustment’ is disabled the above box appears.  
The X, Y and Z angles can be adjusted. The offset value can either be 
added or subtracted. 
 
Normally the ‘No new range’ is enabled and not configured by the user 
unless with consultation from Star-Oddi.  The purpose of this feature is to 
put in a new range when recalibrating the X and Y axis of the compass. 
 
 
Compass Reconvert Definition 
 
Compass offset adjustment 
Under the Edit menu and Reconvert Definition, choose the Compass-
U,V command and a dialog box appears: 
 

 

                            Figure 10.5  Comp-tilt Reconvert Definition 
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As the ‘No angle offset adjustment’ and ‘No new range’ is disabled the 
above box appears.  The Compass heading angle can be adjusted. The 
offset value can either be added or subtracted. Although the DST comp-
tilt is a two channel magnetic measurement device, the software converts 
the values into a single heading value.  The heading value shows the 
Magnetic North. 
 
In order to change the heading value into True Geographic North it is 
necessary to put in an offset adjustment for declination.  The declination 
varies between regions but it is possible to see the declination in each 
area on the internet2.  It is recommended that the user makes reference 
measurements of the comp-tilt heading prior to a study. 
 
The performance of the DST comp-tilt is optimum when it is placed in the 
horizontal plane, the further the comp-tilt pitches and/or rolls from the 
horizontal plane the larger the error reading becomes.  If it is shown that 
the recorder has not been mounted in a 0°C horizontal position it is 
possible to put in an approximate offset value based on the tilting of the 
DST housing. 
 
 
Deployment-Retrieve Locations 
 
Under the Edit menu and Reconvert Definition, choose the 
Deploy/Retrieve Location command and a dialog box appears: 
 

 

              Figure 10.6  Deployment and Retrieval Locations 

                                                 
2 The declination value can be found at www.ngdc.noaa.gov/geomagmodels/struts/calcIGRFWMM 
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Before releasing the DST comp-tilt the user should note down the release 
time and date, latitude and the magnetic field vector.  These information 
should also be obtained upon recapture of the DST comp-tilt.  To 
correct/improve the tilt and magnetic field calculations the user should 
enable that option and insert the information on time-date, latitude, 
magnetic field vector, both for release and recapture of the recorder. 
 
Reconvert data 
After acknowledging the offset adjustments, the data need to be 
reconverted, for the adjustments to be effective: <File\Reconvert Data>.
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11. Recorder Modes 
 
 
In this chapter, the three operational modes of DST comp-tilt are 
described, that is the PC Mode, Sleep Mode and Measurement Mode. 
 
 
PC Mode 
 
If the recorder is in the correct position in the Communication Box, and by 
choosing the Recorder menu and the Connect command, the recorder is 
put into PC Mode.  At the bottom of the SeaStar window, the text On-
line is displayed, indicating that the recorder is on-line and in PC Mode. 
 
While in PC Mode, the recorder will remain in an active listening stage.  
The communication protocol is a simple master/slave arrangement, in 
which the recorder is the slave.  The slave will perform every command 
the PC issues, and after execution of a command, it will return to listening.  
When the recorder is connected to the PC, it is powered by the PC, and 
not taking energy from the battery inside the recorder 
 
 
Sleep Mode 
 
The user receives the recorder in Sleep Mode, but it can easily be 
awakened by the Connect command in the Recorder menu.  If the 
recorder is not set in Measurement Mode, it goes into Sleep Mode when 
the recorder is removed from the Communication Box.  When the 
recorder is in this mode, less energy is depleted from the battery.   
 
 
Measurement Mode 
 
The recorder is put into Measurement Mode by choosing the Recorder 
menu, and Start New Measurements Sequence.  The recorder starts 
recording measurements according to the start time (date/month/year) 
and sampling interval (hours/min.) defined by the user. 
 
When the memory is full, the recorder shifts automatically into Sleep 
Mode.  If the recorder is still in Measurement Mode upon connection 
through a PC computer, it stops recording and is put into PC Mode. 
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12. Memory Organization 
 
 
The memory capacity in DST comp-tilt is 20,000 measurements for each 
sensor.  Data is kept in an EEPROM memory and will not be lost if the 
battery fails or expires.  The memory of the recorder is organized as 
shown in the figure below: 
 

New recordings Unused memory/
Old recordings

VV Data memory

Settings V

 
 

     Figure 12.1  Data memory organization  
 
 
When data is retrieved from the recorder, the following occurs: 

1. The computer retrieves the data from the recorder and writes the 
data to the computer’s hard drive . 
 

2. The recorder has stopped recording, but still holds the recorded 
data. 

 
 
When new settings are sent to the recorder, the following will occur: 

1. New settings are sent to the recorder. 
 

2. The data memory pointer is reset to the beginning of the data 
memory and starts to write over older recordings. 

 
The organization of the memory is now as follows: 
 

Unused memory/
Old recordings

VV Data memory

Settings V

 
 

Figure 12.2  Data memory with new settings 
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Appendix 
 
Directories and Files 
 
Directory structure 
The user can choose between SeaStar’s default data directory structure 
(path) or define his own data path.  As the SeaStar program is a multi 
recorder type program, the directory structure branches from the directory 
where SeaStar is positioned down to type directories, i.e. Starmon mini, 
DST comp-tilt etc.  From there it branches again into recorder directories, 
named after the serial numbers of the recorders, designed to hold data for 
each individual recorder (data directory).  All in all it is a three level 
directory structure. 
 
An example of this directory structure with DST comp-tilt is: 
C:\Seastar\   The installation directory (SeaStar.exe location) 
 
C:\Seastar\DST comp-tilt\  The type directory for DST comp-tilt 
 
C:\Seastar\DST comp-tilt\I2018\ The directory for the I2018 recorder 
 
When a new recorder type is selected in SeaStar (File – New Recorder 
Type), the directory for that recorder type is created.  When connecting to 
a recorder for the first time, SeaStar creates the recorder directory, 
named after the serial number of the recorder. 
 
Information files 
SeaStar uses information files to store and retrieve settings.  There are 
two types of information files: 
1) The type-INI files, (for example DSTx.ini for DST comp-tilt). 

The information type files are all in the installation directory, they 
contain information on specific settings for each type.  The type-INI 
files are: 
StarmonT.ini  Starmon mini 
DSTm.ini   DST milli 
DSTu.ini   DST micro 
DSTc.ini   DST centi 
DSTs.ini   DST CTD 
DSTg.ini   DST GPS 
DSTx.ini   DST pitch & roll 
DSTq.ini   DST compass 
DSTi.ini   DST comp-tilt 
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2) The recorder-INI files, for example I2018.ini contains settings 

information and data file positioning for the I2018 recorder. The 
recorder-INI files are located in the appropriate type directory, i.e. all 
the Qnnnn.INI files are in the ‘DST comp-tilt’ directory. 

 
Files locations 
As stated previously, the type-INI files are placed in the ‘Seastar’ 
directory, and the recorder-INI files are placed in the recorder type 
directory.  All other recorder and measurement related files created by 
SeaStar, are placed in the appropriate recorder’s directory.  For example: 
C:\SeaStar\DST comp-tilt\I2018\ is a directory for the I2018 recorder 
and all files belonging to I2018 are placed there. 
 
If the user whishes to use his own defined data path, for example 
C:\Data\, then all the files for all the recorders, except for the INI files, are 
placed there.  If the user has enabled the “Create recorder directories” in 
the user path definition, individual recorder directories, irrelative to type, 
are created under the user defined path, for example: C:\DATA\I2018\ for 
the I2018 recorder.  The I2018.ini file (located in the C:\SeaStar\DST 
comp-tilt\) contains the path to the C:\Data\I2018\ directory, and all files 
related to the I2018 will be placed in that particular directory. 
 
Browsing for a recorder 
When browsing for a new recorder from the ‘Select recorder’ under the 
files menu, the default method is to find a recorder-INI file in the type 
directory.  The INI file will then point to the data directory (the recorder’s 
directory).  If the user has enabled the “Browse first in the user directory” 
in the user path definitions, the search starts in the user defined directory, 
where a *.RID file must be selected. 
 
Recorder related files 
Every file that is recorder related has the following name format: 
  Xnnnn:  The name is the serial no. of the recorder 
 
 Ext Description       File type 
 RID Recorder  information data    Binary 
 RIT Recorder  information text    Text 
 RBD Recorder backup data     Binary 
 RDD Recorder SNMS∗ download information data Binary 
 RDT Recorder SNMS download information text Text 
                                                 
∗ SNMS: Start New Measurement Sequence 
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The recorder ID (RIT) can at a later time be opened, and the related 
measurement data can be viewed, printed and reconverted.  The RDD, 
RDT and DIR are download information files, created when a new 
measurement sequence is started. 
 
Measurement related files 
Every file that is specifically measurement related has the following name 
format: 
 
 mmmXnnnn: The name is the measurement number + serial no. 
 
 Ext Description      File type 
 MID Measurement information data   Binary 
 MIT Measurement information text   Text 
 MDD Measurement download information data Binary 
 MDT Measurement download information text Text 
 CIT Measurement conversion information text Text 

DAD Measurement Data Binary file   Binary 
DAB Measurement Data Binary file   Text 

 DAT Measurement converted data   Text 
 
The MID, MIT and DAD files are created upon measurement data retrieval 
from the recorder.  The DAB, DAT and CIT files are created when 
converting the data.  The MDD and MDT are download information files 
and created when a new measurement sequence is started. 
 
Data files 
Upon data retrieval, three main data files are created.  
 
The *.DAD file 
This file is the raw data source file.  The data is in mixed binary form.  The 
user cannot access this file in the SeaStar program.  When converting 
these raw data into measurements, the *.MID file is needed.  The result 
from the conversion are two data files, the *.DAB and the *.DAT. 
 
 
 
 
The *.DAB file 
This file contains sequential binary representation of the data in columns.  
The first column is the measurement number.  The other columns contain 
the measured parameters in a binary form. 
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The *.DAT file 
This is the actual result file, where the measurements are converted to 
their natural units and timed.  This is a text file with columns.  The first 
column is the measurement number, the second column the date and the 
time, depending on the set-up.  The third column is the time or the first 
measured parameter, depending on set-up.  The following column(s) 
contain the converted measured parameters with units and number of 
decimals according to set-up.  Number of parameters can range from 1-3, 
and number of columns 3-6 accordingly.   
 
Data header 
The *.DAT file contains a data header, which is a detailed description of 
how the *.DAT file is configured.  This feature is used by SeaStar when 
graphically representing the data, and is practical if the user wants to 
import the data into other applications or databases.  Most of these 
descriptive items are derived from the ‘Settings’ menu and the recorder 
type definition in the ‘File’ menu. 
 
Each header item is contained in one line, and all header lines start with a 
#  (bookmark) and a number.  Then follows a description of the header 
item, and then 1-4 directives, all separated by tabs.  Eventually a comment 
trails the directives, preceded by a ; (semicolon) 
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Troubleshooting 
 
 

Connecting to the recorder 
In order to be able to communicate with the recorder, the three lights on 
the communcation box need to be lit.  The red light is the power, the 
yellow light is the PC communication, and the green light is the recorder 
communication.   
 
No red light 

1. Check if the DC power supply is plugged in. 
2. Check if the polarity of the connector is correct.  The plus should be 

on the inside and the minus on the outside, +O)- 
 
No yellow light 

1. Check if the correct recorder type has been selected under the 
‘File-Recorder Type’ menu. 

2. Check if the red light is on. 
3. Check the cable connection between the PC and Communication 

Box.   
4. Check if the correct COM port has been selected (see chapter 3). 
5. Check if the power on (PowOn) indication is shown at the bottom 

of the SeaStar window.   
 
No green light 

1. Check if the red and yellow lights are on. 
2. Check if the voltage selection on the AC/DC adaptor is set to 9V or 

higher (220V AC). 
3. Check if the recorder is inserted correctly into the hole in the box.  

The spherical end should face down. 
4. Insert the recorder into the hole, and rotate until stable green light 

comes on.  If necessary, remove recorder from box and repeat the 
insertion and rotation of recorder in the box.   

5. Lift the recorder a few mm up in the box, hold it for two seconds 
and put it down in the box again. 

 
Unstable green light 

1. Try rotate the recorder in the hole in the box, until green light 
becomes stable. 

2. If using a laptop, make sure that the DC power supply for the 
laptop, is kept as far away as possible from the Communication 
Box. 
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3. If out on sea, the recorder may be move around in the hole.  To 
immobalise the recorder in the correct position, try using a slip of 
paper, and squeeze it down the hole, alongside the recorder.   

4. If the recorder comes with a plastic tube attached, make sure that 
the tube goes all the way through the hole on the bottom of the box, 
so that the recorder is placed on the correct level for 
communication. 

 
Communication errors 
All three lights on the box are on.   

1. Check if the voltage selection on the AC/DC adaptor is set to 9V or 
higher. 

2. Most probable cause is that, although the green light may seem 
stable, the communication link is weak.  Try to rotate the tag slightly 
in the hole, and try to connect again.  Repeat if necessary.  The 
recorder should be rotated to the center of the stable green light 
range (see chapter 4). 

3. If using a laptop, please make sure that the power cable/DC power 
supply are located as far as possible away from the Communication 
Box and the communication cable. 

4. Make sure that no electrical devices/power sources are close to the 
communication cable/box. 

5. When trying to connect to recorder on a moving boat, the recorder 
may move around while trying to connect, and causing 
communication errors.  Put a piece of paper at the sides of the 
recorder in the box.  This will keep it from moving. 

6. If a ‘Device Error’ is reported upon connection, please check if the 
SeaStar program has been opened more than once. This error can 
also occur if a different program is open, and is using the same 
communication port as SeaStar. 

 
CRC error 
The CRC test is a safety check performed by the software when retrieving 
the Recorder Information Data (RID).  The CRC is a register in the RID 
file, which is calculated and placed in the recorder’s RID, when starting up 
a new measurement sequence.  When retrieving the RID from the 
recorder, SeaStar calculates the CRC from the retrieved data, and 
matches it against the recorder’s CRC register.  If they do not match, a 
CRC error is reported. 
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The reason why a CRC error occurs, is most likely due to bad 
communication condition.  Check the point above, under ‘Communication 
errors’.   
It is possible to disable the CRC check while connecting.  This is done 
under ‘Settings – Connection’.  Normally, the CRC should not be 
disabled, but the following scenarios are an exception, where CRC check 
can be disabled: 

a) A communication error occured while connecting.  Please check the 
5 points above before disabling CRC check. 

b) A communication error occured while inititating a new measurement 
sequence. 

c) A communication error occured after data retriaval, while updating 
status in the recorder. 

d) A communication error occured while putting the recorder to sleep. 
e) A communication error occured while updating status in the 

recorder upon a POR (Power On Reset) error detection.  When 
connecting to the recorder and POR error is detected, a new status 
is initiated in the recorder and the RAM data is reset. 

f) Repeated CRC error occurs, and the above does not apply/has 
been checked.  This may though produce errors in the RID file, 
which again may produce errors in the conversion of data. 

 
Disable CRC check: 

1. Go to ‘Settings – Connection’, and disable the ‘Perform 
CRC test when retrieving RID. 

2. Try connect to the recorder ‘Recorder – Connect’. 
3. If connection is OK, then examine the RIT file for possible 

error.  These possible errors may manifest themselves as a 
very high (>E20), or very low (<E-20) calibration 
constants.  Other errors may be abnormal times/dates and 
abnormally high measurement sequence number in the RIT 
file.  Usually SeaStar will come up with a warning if the 
calibration constants or time/date is not normal.  If the RIT 
shows signs of these error, please request record backup 
file (RBD) from Star-Oddi.   

4. If the recorder has been measuring data, try to retrieve the 
data ‘Recorder – Retrieve Data’.  If data can not be 
retrieved there is fault with the PC com port, the 
Communication Box /cable, or the recorder.  If data 
retrieval was ok, continue to step 5. 
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5. Make a short measurement test and start the recorder in a 
new measurement sequence ‘Recorder – Start New 
Measurment Sequence’. 

6. Enable the CRC check ‘Settings – Connection’. 
7. Connect to the recorder after the short measurement test, 

‘Recorder – Connect’.  If a communication/CRC error 
occurs,  

8. then there is fault with the PC com port, the 
Communication Box /cable, or the recorder.   

9. Retrieve data from the short test ‘Recorder – Retrieve 
Data’.  Analyse the data, and verify that the values are 
correct. 

 
 
Starting a new measurement sequence 
 
Communication errors 

1. Timeout on command echo (no response from recorder). 
a) Check if the voltage selection on the AC/DC adaptor is set to 

9V or higher. 
b) This may happen because the recorder has moved in the 

hole, or has been removed (and inserted again into the hole).  
The recorder is off-line.  Please try to connect again.   

2. Other communication errors. 
Other communications problems can occur, but the recorder is still 
on-line.  The user is prompted to try starting the recorder again in a 
new measurement sequence.  If the user chooses to connect to the 
recorder again, a CRC error will most likely occur.  In that case, the 
user should disable the CRC check (Settings – Connection).   

 
 
Retrieving data 
 
Communication errors 

1. No data retrieved. 
This is likely to happen due to the battery is dead, or has failed.  The 
recorder has therefore not taken measurements.  To verify if the 
battery is dead, the following can be carried out: 

a) Insert the recorder into the box, so that all lights are on.  
b) In SeaStar, choose ‘Settings – Communications – Serial Ports’ and 

set the ‘Port Enable/Power’ to be OFF.  Before pressing the OK 
button, watch the yellow and green lights carefully:  
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a) Press OK.  If the green light goes off ca. two seconds later 
than the yellow light, there is still battery life remaining. 

b) If the green and yellow lights go off at the same time when the 
OK button is pressed, the battery is dead. 

 
But remember that after these steps, you have to go back to ‘Settings – 
Communications – Serial Ports’ and set the ‘Port Enable/Power’ to be 
ON.  That way you can only get all the lights back on.   

 
2. Timeout on command echo. 

There is no response from recorder.  This may happen because the 
recorder has moved in the hole, or has been removed (and inserted 
again into the hole).  The recorder is off-line.  Please try to connect 
again and retrieve data.   

3. Other communication errors while retrieving data. 
The result of the retrieval can be viewed in the .MIT file.  Usually, if 
the communication is in order, and all the data is retrieved correctly, 
SeaStar will automaticlly convert the data from the decimal values 
(.DAD), to the unit values (*.DAT).  If this is not the case, then 
SeaStar may drop the conversion part, and it is up to the user, to 
either retrieve the data again, or manually convert the data (see 
chapter 10), depending on the status of the retrieval. If a 
communication error occurs in the middle of data retrieval, the 
recorder becomes off-line.  The user must connect to the recorder 
again, and retrieve the data again. 

4. Communication errors while updating recorder status. 
In the event when communication error occurs while updating the 
status in the recorder, i.e. after retriving the data,  the CRC register 
in the recorder is probably corrupt.  Thus when connecting again to 
the recorder, a CRC error will likely occur.  If so, please disable 
CRC check as described under ‘CRC error’ earlier in the appendix. 
 

Graph and data table not displayed 
If the software has not been installed from the CD, and only the 
‘seastar.exe’ file is running, the graph and data table will not appear.  This 
may be the case when the user has a new computer, and gets the latest 
version of SeaStar from Star-Oddi, runs only the ‘seastar.exe’ file, and has 
not previously installed SeaStar from the CD.  The software must be 
installed from the CD (by running the ‘setup.exe’ file), because it installs 
the package for creating the graphs and tables.  The ‘seastar.exe’ file can 
be updated later with a new ‘seastar.exe’ file. 
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When data is retrieved using the ‘seastar.exe’ file only, the data is 
retrieved OK, although the graph and table will not display.  The data can 
be opened in Excel, or viewed after installing the software from the CD. 
 
 

Windows Settings 
 
Windows XP 
Graph not displayed in SeaStar 
SeaStar may retrieve the data, create the DAT file but come with a 
message indicating an error reading the DAT file, and graph not displayed.  
This may be caused by a user setting feature in Windows XP.  The user 
has to be set as an administrative in order to view the data graphically in 
SeaStar.  The user accounts can be viewed and possibly changed by 
performing the following: 

 
Go to ‘Control Panel’ and double click on ‘User Accounts’ 
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Choose ‘Change an account’. 
Pick your account.  If you are already set as ‘Computer administrator’, 
please stop here and exit all windows. Otherwise continue by clicking on 
your account. 
 

 
If you are not set as ‘Computer administrator’, choose ‘Change my 
account type’. 
Enable the ‘Computer administrator’. 
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Windows Vista 

 
The same problem as described for Windows XP can occur in Windows 
Vista. To run the program as an administrator you will have to do 
following: Right-click on the SeaStar icon and select ‚Properties‘. Click on 
the ‚Compatibility‘ tab and you will see following:  
 
Under section ‚Privilege Level‘ check ‚Run this program as an 
administrator‘, click Apply and OK.  
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